CHECK MAGAZINE TUTORIAL: PART 5
Adding Another Page

In Part 5, you will learn…
Welcome to Part 5 of this 6-part tutorial series on creating your first website. In the first four parts, you created a site in Dreamweaver CS6 and built the home page for Check Magazine, a fictional publication, using HTML and CSS. However, a single page is rarely sufficient for a website. This part will show you how to create a second page and adapt the styles to give it a distinctive look while remaining in harmony with the original page.

There are no hard and fast rules about the correct or best way to add extra pages to a website. In this tutorial, you’ll learn about just one method—copying an existing page and replacing its content. To style some parts of the page differently from the original, you’ll add a class to the second page’s body tag. You’ll also learn how to solve conflicts between style rules. Some of the information in this part might seem advanced for a first website, but it tackles problems that frequently arise. Don’t try to rush. Take it slowly.

[bookmark: articlecontentAdobe_numberedheader]Locate your files and review your task
[bookmark: articlecontentAdobe_text_0]If you completed the first four parts of this tutorial series, continue working with your existing files. If you’re not sure that your HTML and CSS is correct, you can download the check_cs6_pt4completed file from the Shared folder, and use it to replace your existing files. The image below shows the home page of the Check Magazine site as it looked at the end of Part 4 of this series.

[bookmark: articlecontentAdobe_image][bookmark: _GoBack][image: Figure 1. The home page of the Check Magazine site after completing the steps in Part 4.]
The home page of the Check Magazine site after completing the steps in Part 4.
[bookmark: articlecontentAdobe_text_1]The page is dominated by a large image. This type of image, often called a hero image, is common on the home page of websites, but repeating this layout on inner pages is probably not a good idea. A hero image is good for setting the mood of a landing page, but inner pages normally give greater prominence to text. The three-column layout at the bottom of the page is good for short snippets of information, but a two-column layout is better for longer items. So, the task is to copy this page, and adapt the styles to create the layout shown in Figure 2. You’ll also link between the two pages, create a link to an external website, and create a home link.

[bookmark: articlecontentAdobe_image_0][image: Figure 2. The design for the inner page is adapted from the existing styles.]
The design for the inner page is adapted from the existing styles.

-------------------------------------------------------------------------------------------------------------------------
[bookmark: articlecontentAdobe_text_37]
[bookmark: articlecontentAdobe_numberedheader_5]Prepare the inner page
[bookmark: articlecontentAdobe_text_2]The first stage in creating a page is to copy the home page and remove elements that aren’t required.
1. In Dreamweaver, open index.html in the Check Magazine site.
2. Choose File > Save As, and save the page as news.html in the Check Magazine site root.
3. [bookmark: articlecontentAdobe_text_3]Close index.html to avoid editing it by accident.
4. Click anywhere inside the main image, and select <div.main_image> in the Tag selector at the bottom of the Property inspector (see image, below).

[bookmark: articlecontentAdobe_image_2][image: Figure 4. Selecting the main_image <div> in the Tag selector.]
Selecting the main_image <div> in the Tag selector.

5. [bookmark: articlecontentAdobe_text_4]Press Delete to remove the main_image <div> and all its contents.
6. Click anywhere in the center column, and select <div.center_column> in the Tag selector.
7. Press Delete to remove the center_column <div> and all its contents.
8. Select all the content in the left_column <div> and delete it (but not the <div> itself). You should be left with an empty paragraph inside the <div>.
9. Repeat the previous step with the right_column <div>. You should be left with a skeleton structure from which the original content has been removed (see image, below).
10. Save news.html.

[bookmark: articlecontentAdobe_image_3][image: Figure 5. The page with the original content stripped out.]
The page with the original content stripped out.


[bookmark: articlecontentAdobe_text_5]Add new content
To make it easier to see the effect of changes to the styles, you need to add some content to the empty columns at the bottom of the page.

1. Locate news.txt in the assets folder, and double-click to open it in the Document window.
2. Press Ctrl+ to select all the content of news.txt.
3. Copy the selected text to your clipboard by pressing Ctrl+C. Alternatively, right-click and select Copy from the context menu.
4. Click the news.html tab to return to the HTML page.
5. Position the insertion point inside the empty paragraph in the right_column <div>, and paste the text from your clipboard (Ctrl+V). Because you pasted into an existing paragraph and each block of text in news.txt is separated by two newline characters, Dreamweaver automatically treats each block as a new paragraph. This avoids the need to remove <br> tags as you needed to do in Part 4.
6. Copy the first paragraph (beginning with "BuzzCycle"), and paste it into the empty paragraph at the top of the left_column <div>.
7. Press Enter to insert a new paragraph after the one you have just pasted.
8. Scroll down the right_column <div> to find the paragraph that begins with "Sousa revives."
9. Copy the paragraph, and paste it into the left_column <div>. Then press Enter/Return to create a new paragraph.
10. Locate the paragraph that begins with "DJ L-Koo teams" in the right_column <div>. Copy and paste it into the left_column <div> (see image, below).
11. Save news.html, and close the text file, news.txt.

[bookmark: articlecontentAdobe_image_4][image: Figure 6. The page now has some content ready for styling.]
The page now has some content ready for styling.
-------------------------------------------------------------------------------------------------------------------------
[bookmark: articlecontentAdobe_text_6][bookmark: articlecontentAdobe_numberedheader_4]
Style the inner page differently
[bookmark: articlecontentAdobe_text_34]Because news.html was copied from index.html, it’s attached to the same style sheet, check_cs6.css. As a result, the header content and navigation bar are styled the same way. The problem is that the columns also inherit the same styles. A common way to create different styles for specific pages is to give the <body> tag an ID or a class. You can then create different rules using descendant selectors. Use an ID if the page is going to have unique styles of its own. If several pages are going to share the same styles, use a class. Even though you might not realize it, you’ve been using descendant selectors throughout this tutorial series. 

A descendant selector consists of two or more selectors with a space between them. For example, “.header a” is a descendant selector that styles links inside an element with the class “header.”

Adding a class to the <body> tag
The quickest and easiest way to add a class to the <body> tag is in Code view.
1. [bookmark: articlecontentAdobe_text_7]With news.html the active page in the Document window, click the Split button to reveal Code view.
2. Scroll down to locate the <body> tag (it should be around line 10).
3. Put your insertion point just before the closing angle bracket, and press Space to insert a space and bring up code hints.
4. [bookmark: articlecontentAdobe_text_8]Type cl to select class, and press Enter (Windows). Dreamweaver autocompletes the class attribute followed by an equals sign and a pair of quotes. Type two_col between the quotes. The <body> tag should now look like this:
· <body class="two_col">
5. Save news.html.

Styling the columns
You can now use the two_col class to create separate style rules for the columns.

1. In the CSS Designer, add a new Selector called “.two_col .left_column.” In the Properties section, make the following changes:
· Color: white (#ffffff) *Don’t forget to change your color format from RGBa to Hex
· Background-color: dark gray (#666666) 
· Padding, top and bottom: 0px
· Padding, left and right: 10px
The left column on the page should now have a grey background with white text atop it.

[bookmark: articlecontentAdobe_image_7][bookmark: articlecontentAdobe_image_8][image: Figure 10. The left column has been restyled.]
The left column has been restyled.

9. [bookmark: articlecontentAdobe_text_10]Open index.html to verify that it hasn’t been affected by the change you have just made to the styles. If it has, you’ve made a mistake, and it would be a good idea to retrace your steps.
10. Close index.html. Click Yes when Dreamweaver asks if you want to save the changes to check_cs6.css. 
11. You now need to fix the width of the right_column <div> in news.html. The total width available inside the container <div> is 968px. 
· The left_column <div> is 316px wide, but you have just added 10px of padding to the left and right sides. 
· Padding is added to the width, making the overall width of the left_column <div> 336px (316 + 10 + 10)
· That leaves 632px (968 – 336 = 632)
· But the right_column <div> has a left margin of 10px. 
· So, that means the width needs to be 622px (632 – 10 = 622).
2. Now you’ve calculated the width, in the CSS Designer, add a new Selector called “.two_col .right_column.” In the Properties section, make the following changes:
· Width: 622px
The two columns now fill the full width of the container <div> (see image, below).

[image: Figure 11. The original three-column layout now has two columns.]
The original three-column layout now has two columns.

12. Save the style sheet.
[bookmark: articlecontentAdobe_image_9][bookmark: articlecontentAdobe_text_12]
***Note: If you test the page in Live view or a browser, the columns don’t sit alongside each other because the Check main heading is floated, preventing the left column from moving to the left side of the container. This problem will be fixed later when a page heading is added between the header and columns.***

Improving the look of the right column
The right column contains a series of posts or articles. The first paragraph in each one needs to be converted to a heading and styled together with the date it was posted.

1. Click anywhere inside the first paragraph in the right column. In previous parts, you used the Format menu in the Property inspector to convert a paragraph into a heading. This time, you’ll use a keyboard shortcut. Press Ctrl+3 to convert the paragraph to an <h3> heading.

Note: Holding down the Ctrl key and pressing a number between 1 and 6 creates a heading the same level as the number from <h1> through <h6>.

2. Do the same with the paragraphs that begin with "Sousa revives" and "DJ L-Koo."
3. Delete the paragraphs inside the right column that contain only four hyphens. They were included only to make it easier to identify the headings.
4. Drag (highlight) to select the first heading and the following paragraph in the right column (see image, below). (It’s easier to drag from the end of the paragraph.)

[bookmark: articlecontentAdobe_image_10][image:  Figure 12. The heading and first paragraph have been selected and are ready for styling.]
The heading and first paragraph have been selected and are ready for styling.

5. [bookmark: articlecontentAdobe_text_13]In the Insert panel, click Div. 
6. In the Insert Div Tag dialog box, make sure that Insert is set to Wrap Around Selection, and type post_header as the Class. Then click ok.

[bookmark: articlecontentAdobe_image_11][image: Figure 13. Creating a style for the post_header class.]
Creating a style for the post_header class.

7. In the CSS Designer, add a new Selector called “.post_header.” In the Properties section, make the following changes:
1. Background-color: Medium-gray (#999999)
2. Padding, top and bottom: 2px
3. Padding, left and right: 10px
The heading and the paragraph that follows it now have a medium gray background, and the text is inset from the left side by 10px (see image, below).

[bookmark: articlecontentAdobe_image_12][image: Figure 14. The heading and following paragraph have been styled differently.]
The heading and following paragraph have been styled differently.

8. [bookmark: articlecontentAdobe_text_15]The heading and following paragraph need a little more tweaking. In the CSS Designer, add a new Selector called “.post_header h3” In the Properties section, make the following changes:
1. Margin, top: 5px
2. Margin, bottom: 10px
9. In the CSS Designer, add a new Selector called “.post_header p” In the Properties section, make the following changes:
1. Font-size: 12px
2. Color: white (#ffffff)
3. Margin, all: 0px
The "Posted on" text is now white (see image, below).

[bookmark: articlecontentAdobe_image_13][image: Figure 15. The heading and date posted have been restyled.]
The heading and date posted have been restyled.

[bookmark: articlecontentAdobe_text_16]After all that work, styling the next two headings is a piece of cake. All you need to do is to wrap a <div> around each one, and set its class to post_header.

10. Select the next heading (beginning "Sousa revives") and the following paragraph.
11. Use the Insert panel to insert a <div>.
12. In the Insert Div Tag dialog box, click the down arrow to the right of the Class field, and select post_header from the list (see image, below). Then click OK.

[bookmark: articlecontentAdobe_image_14][image: Figure 16. Dreamweaver lists available classes for you to select.]
Dreamweaver lists pre-existing classes for you to select

[bookmark: articlecontentAdobe_text_17]Note: Although you can apply more than one class to an element, the list in the Insert Div Tag dialog box allows you to select only one. To learn how to apply multiple classes to an element see Adobe TV: Selecting multiple classes in Dreamweaver CS6.

13. Repeat the previous three steps for the final heading (beginning "DJ L-Koo") and the following paragraph. 
14. The text in the headings is indented by 10px, putting them out of alignment with the remaining paragraphs in the right column. You need to create another style rule to add the same amount of padding to the paragraphs. Click anywhere inside the right column except in the three post_header <div> elements that you have just styled.
15. In the CSS Designer, add a new Selector called “.two_col .right_column p,” and under the Property section, make the following changes:
· Padding, left and right: 10px
The paragraphs in the right column are now in alignment with the headings (see image, below).

[bookmark: articlecontentAdobe_image_15][image: Figure 17. The paragraphs have been moved 10px from the sides of the <div>.]
The paragraphs have been moved 10px from the sides of the <div>.

25. [bookmark: articlecontentAdobe_text_18]Choose File > Save All Related Files to save the web page and style sheet.

[bookmark: articlecontentAdobe_numberedheader_0]------------------------------------------------------------------------------------------------------------

Resolve a conflict between rules
[bookmark: articlecontentAdobe_text_11]If you look carefully, you’ll notice that the paragraph inside each post_header <div> has also moved in 10px. That’s because the selector .two_col .right_column p affects all paragraphs inside the right_column <div> in a two-column layout. The fact that the paragraph is nested inside another <div> makes no difference. To prevent the 10px padding from being applied to the paragraph inside the post_header <div>, you need to edit the .post_header p style rule to set its left padding to 0.

However, as you’ll discover in the following section, eliminating the padding isn’t as straightforward as you might think. This introduces you to the precedence accorded to style rules when there’s a conflict—a principle technically known as specificity.

1. Select the .post_header p style rule in the CSS Designer.
2. Add the following Property:
1. Padding, left: 0px
Even though you have set the left padding on the paragraph to zero, it remains indented. 

[bookmark: articlecontentAdobe_text_21]So, why hasn’t changing the padding of the “.post_header p” Selector to 0px removed the left padding? The answer lies in the specificity of the selectors—put simply, .two_col .right_column p is a more powerful selector than .post_header p.

You can work out the specificity of a selector by assigning imaginary values to each part of the selector, and adding them up. The higher value wins.
· Each ID has a value of 100.
· Each class has a value of 10.
· Each tag selector has a value of 1.

Note: In the preceding section, I simplified the way specificity is calculated. The complete list of values assigned to selectors is as follows: IDs have a value of 100; classes, pseudo-classes, and attribute selectors have a value of 10; tag selectors and pseudo-elements have a value of 1. Inline styles specified using the style attribute in an element’s opening tag always take precedence.

Using these values, .two_col .right_column p consists of 2 classes and 1 element selector, so it has a value of 21. But .post_header p consists of only 1 class and 1 element selector, so its value is 11. Specificity applies only to conflicting properties. That’s why the font-size, color, and margin properties are applied, but padding-left isn’t.

There are two ways to solve this problem: the lazy way and the better way. I’ll show you both.

1. In your CSS, in Code view, put your insertion point just before the semicolon at the end of the padding-left definition in the .post_header p style rule (on line 122 in Figure 19), and press Space. This brings up code hints, as shown below.

[bookmark: articlecontentAdobe_image_18][image: Figure 20. Editing the padding-left definition in Code view.]
Editing the padding-left definition in Code view.

2. [bookmark: articlecontentAdobe_text_22] Select !important from the code hints. The padding-left definition now looks like this: 

padding-left: 0px !important;

3. Press F5 or click in Design view to refresh the page. The padding has been removed from the paragraph in the header, and it’s now correctly aligned with the other text (see image, below).
[bookmark: articlecontentAdobe_image_19][image: Figure 21. The paragraph is now correctly aligned.]
The paragraph is now correctly aligned.

[bookmark: articlecontentAdobe_text_23]Adding !important just before the semicolon at the end of a property definition is a quick and dirty way to resolve a conflict IN DREAMWEAVER, but it has the disadvantage that it needs to be added to individual properties. You can’t apply it to a complete style rule. A more serious problem is that, if you rely on !important to resolve all conflicts, you’ll quickly discover you’re creating conflicts between !important rules and you don’t have a way to resolve them.

Treat !important as an emergency life vest, but use the rules of specificity to ensure your boat doesn’t spring a leak in the first place.

The better way to solve this problem is to create a selector with equal or higher specificity.

4. Delete !important from the padding-left definition in the .post_header p style rule 
5. [bookmark: articlecontentAdobe_codeblock]The post_header <div> is nested inside the right_column <div>, so add “.right_column” to the beginning of the selector like this: 

[bookmark: articlecontentAdobe_text_20].right_column .post_header p { font-size: 12px; color: #FFF; margin: 0px; padding-left: 0px; } 

The selector now consists of 2 classes, and 1 element selector, which adds up to a specificity of 21, the same as .two_col .right_column p. When you look at your website in Design view, however, you will see that STILL, nothing has changed.

Since the two styles are now EQUAL in terms of their specificity rating, based on their selectors, we now need to change their order in the CSS stack – remember, the lower a style rule is in the CSS stack, the closer it is to the html content; the closer it is to the HTML content, the more impact it has over the design. 

In your CSS code, copy the “.right_column .post_header p” Selector, and paste it below the “.two_column .right_column p” selector. 

6. Refresh Design view to confirm that the paragraph inside the header is still correctly aligned
7. Save the style sheet.

Note: Resolving this sort of conflict is probably one of the most challenging aspects of styling websites with CSS. I could have avoided this problem by always accepting the value Dreamweaver suggests for Selector Name in the New CSS Rule dialog box. However, selector names should be kept as simple as possible to reduce the amount of work the browser needs to do to apply the styles.

[bookmark: articlecontentAdobe_numberedheader_1]------------------------------------------------------------------------------------------------------------

Add a page heading
[bookmark: articlecontentAdobe_text_35]The page needs a heading between the header <div> and the two columns. Adding the heading solves the problem of the columns not displaying correctly in Live view or a browser, but it creates a different challenge that requires some creative thinking.

The page heading needs to go between the header <div> and the left_column <div>. Although the Insert Div Tag dialog box makes it easy to insert a <div> element precisely, there’s no equivalent for <h2> tags. So, the simplest way to make sure the heading is inserted in the right place is to dive into Code view.

1. Select Source Code in the Related Files toolbar to expose the HTML in Split view.
2. The quick way to find the correct place to insert the heading is to select the left_column <div> in Design view. This highlights the <div> in Code view.
3. In Code view, click at the end of the line above the highlighted <div> (as soon as you do so, the <div> is no longer highlighted), and press Enter/Return to insert a new line.
4. On the blank line you have just created type the following line of code:
<h2>Point of View</h2>
5. Click the Live button to turn on Live view, which will show this new heading (see image).

[bookmark: articlecontentAdobe_image_20][image: Figure 22. The page heading has been added, but needs to be styled.]
The page heading has been added, but needs to be styled.

6. [bookmark: articlecontentAdobe_text_24]With Live view still active, click anywhere on the words "Point of View." 
7. In the CSS Designer, add a new Selector called “.two_col h2.” In the Properties section, make the following changes:
· Font-family: Arial Black, Gadugi, sans-serif
· Font-size: 72 px
· Font-variant: small-caps
· Word-spacing: 0.3 em
· Text-align: center
· Margin, top: 0px
[bookmark: articlecontentAdobe_image_21][bookmark: articlecontentAdobe_text_25]The margins are removed, but the heading has moved mysteriously to the right, as shown:

[bookmark: articlecontentAdobe_image_22][image: Figure 24. The heading is no longer centered.]
The heading is no longer centered.

[bookmark: articlecontentAdobe_text_27]The clue to what’s happening is that the heading is centered between the word "Check" in the header <div> and the right side of the container <div>. In Part 3, you floated the Check heading left. Floated elements can extend below their parent element—in this case, the header <div>—preventing subsequent elements from moving past the floated element. Although the Check heading has no bottom margin or padding, its text box is invisibly protruding below the header <div>. Removing the top margin from the Point of View heading results in the two elements colliding.

One way to solve this problem is to increase the height of the header <div> by about 10px, but that makes it too tall. The other solution is to use the clear property on the Point of View heading.

8. In the Properties section, make the following changes:
· Clear: left
· Position: relative
· Placement Top: -30px (Setting Top to a negative value moves the heading up, but the columns remain in their previous position. This is because relative positioning moves the target element without affecting other elements.)
· Margin, bottom: -35px
9. File > Save All Related Files to save your work.

-------------------------------------------------------------------------------------------------------------------------

[bookmark: articlecontentAdobe_numberedheader_2]Link the two pages
[bookmark: articlecontentAdobe_text_26]Now that you’ve got two pages in the Check Magazine site, you can link them together.

Linking to internal files
Dreamweaver offers several ways to create links.

1. Open index.html in the Document window.
2. In the index.html document, click anywhere in the News link in the navigation bar. Because it already has a dummy link, you don’t need to select the whole word.
3. With the HTML button selected in the Property inspector, click the Browse for File icon to the right of the Link field to open the Select File dialog box (see image, below).

[bookmark: articlecontentAdobe_image_24][image: Figure 26. Browsing for the file you want to link to.]
Browsing for the file you want to link to.

4. [bookmark: articlecontentAdobe_text_29]Make sure you’re in the Check Magazine root folder (click the Site Root button if you’re not sure—it’s at the top of the dialog box in Windows). Select news.html, and click OK. The correct path to news.html is now displayed in the Link field.

[bookmark: articlecontentAdobe_image_25][image: Figure 27. The link has been created.]
The link has been created.

[bookmark: articlecontentAdobe_text_30]Note: In this case, only the file name is displayed because index.html is in the same folder as news.html. When linking to files in other folders, Dreamweaver makes sure the correct path is used. Getting Dreamweaver to insert the path is more reliable than typing it directly into the Link field.

5. In the “index.html” document, select the "read more. . ." text at the bottom of the left_column <div>. Because there isn’t an existing link, you need to select all the text that you want to convert to a link.
6. Click the Point to File icon next to the Link field (it looks like a crosshair sight), hold down the mouse button, and drag the crosshair to the Files panel. Release the mouse button when the crosshair is over news.html 


[bookmark: articlecontentAdobe_image_28][image: Figure 28. You can create a link by dragging the Point to File icon to the target file.]
You can create a link by dragging the Point to File icon to the target file

[bookmark: articlecontentAdobe_text_31]The correct path to news.html is displayed in the Link field.

Creating external links
Creating an external link is very straightforward. You just type or paste the URL into the Link field in the Property inspector or the Hyperlink dialog box.The important thing to remember is that external links must include the http:// or https:// (for secure links) at the beginning of the URL. If you leave the HTTP protocol out of the URL, the link will be treated as internal, resulting in the page not being found. To avoid typing mistakes, it’s best to copy the link from the address bar of your browser, and paste it into the Link field.
1. Select the "read more. . ." text at the bottom of the .center_column <div>, and link to an external site of your choice.
2. Save index.html.

Test the links
Load index.html into a browser by pressing F12, and test the links to make sure they open news.html and the external site. There’s no link to return from news.html to the main page, so just use your browser’s back button for the time being.

Creating a home link
When drawing up the original comp for the Check Magazine site, the designer didn’t include a Home link in the navigation bar (these things happen!). There is sufficient room to add an extra link at the beginning of the navigation bar, so I’ll leave you to handle that by yourself. However, it’s also common to make the logo or site name link back to the home page.

Adding a link to the Check heading sounds easy enough because it’s just text in a pair of <h1> tags, but doing so affects how it’s styled.

1. In the “news.html” document, select the word "Check" in the header <div>. Create a link to index.html using one of the methods described earlier. As soon as you create the link, the text size shrinks (see image, below).

[bookmark: articlecontentAdobe_image_27][image: Figure 30. Adding a link to the main heading affects how it’s styled.]
Adding a link to the main heading affects how it’s styled.

[bookmark: articlecontentAdobe_text_33]What’s happened is that the text is now affected by the styles used by the navigation menu. You need to create a new rule for this link, restoring it to its original size, and removing the small capitals and narrower width.

2. With the link you have just created still selected, in the CSS Designer, add a new Selector called “.header h1 a” In the Properties section, make the following changes:
· Font-size: 96px
· Font-variant: normal
· Width: auto

Note: The Check link will be affected by both the #header h1 a and #header a styles. But the former selector has a higher specificity (102 as opposed to 101). As a result, the #header h1 a style rule overrides #header a.

3. Click OK, and choose File > Save All Related Files.
4. [bookmark: articlecontentAdobe_numberedheader_3]Test the page again. You can now click the Check logo to return to the home page.

-------------------------------------------------------------------------------------------------------------------------

Bonus
Now that you know all about adding and adjusting images, and positioning elements within your page, see if you can add a series of relevant images to the left column of your “news.html” page to balance out the height of the right column with the left.

-------------------------------------------------------------------------------------------------------------------------





Review Questions:
1. What are some typical content and formatting differences between a website’s home page and its interior, or, subpages?
2. Why do web designers add additional ID and Class selectors to the same style sheet (.css) to style all the pages inside their website? 
3. What is a descendent selector?
4. When working with multiple webpages, when should you use an ID vs. a Class selector?
5. In both the “index.html” and “news.html” documents’ CSS (since they share the same style sheet), the right_column (#right_column) selector is set to 316px. Why is it, then, that we are able to change the width of the right column to 622px in the “news.html” document by adding a new CSS Rule to the “.two_col” Class selector (in step 7 on page 13)? Hint: look in your CSS Code view. You should see some Descendent Selectors. Which of the 3 Theories is at work here?
6. Why is it so easy to style elements using Class selectors?
7. Following the Specificity Theory, put these Selectors in order of their “Power” level – 1 being most powerful, 3 being least powerful:
a. Class
b. ID
c. Element
8. State and describe the 2 ways of fixing a “conflicting property” problem.
9. Even though Dreamweaver assigns complex default selectors whenever you create a new CSS Rule, why is it a good idea to manually simplify these rules as much as possible?
10. What CSS property can we use to help solve positioning (using the float property) issues?
11. What are 3 different ways pages can be linked inside Dreamweaver?

-------------------------------------------------------------------------------------------------------------------------

Where to go from here
[bookmark: articlecontentAdobe_text_36]Congratulations! You’ve created the home page and an inner page for the Check Magazine site, and you’ve learned a lot about HTML, CSS, and Dreamweaver along the way. After you’ve completed the assignment (see ASSIGNMENT handout), the final part of this tutorial series will show you how to publish the pages and their assets to a web server so that other people can view your work. I’ll show you how to connect to a web server and upload your files in Part 6: Publishing your website. Though we won’t actually be publishing our sites in this class, it is still a very handy thing to know how to do in case you want to publish the websites you build after taking this course!

16

image4.jpeg
Ch FASHION + LIFESTYLE
ec FEATURES! FASHION [LIFESTYLECALENDAR _NEWS





image5.jpeg
: Ch FASHION + LIFESTYLE
i ec FEATURES; FASHION LIFESTYLECALENDAR _NEWS

i BuzzCycle sets new landspeed record for
{ ‘electric vehicles

BuzzCycle sets new landspeed record for
lectric vehicles

{ Sousa revives Noir with sultry thriller Posted on October 16, 2012

i DJ L-Koo teams with calendar girls to
faunch new Hollywood hangout

In yet another instance of green tuming

imean, famed electric-powered drag racing

wo-wheeler BuzzCycle has set a new

fandspeed record for electric vehicles,

H iposting a quarter mile time of 8.083
iseconds at Cape Coral Drag Speedway last

i iweekend

H ‘At a maximum output of 3200 kw/sec,

i BuzzCycle can unleash enough torque to
ifinish the quarter mile within a few

i ithousandths of a second of leading gas-
ipowered drag racing motorcycles. This
capability, combined with an eerie lack of
iengine noise, has sparked a new nickname

ifor the cycle and driver Marty Watts
Wiolence.




image6.jpeg
PTGV NP PRSP Rl 5uz2Cycle sets new landspeed record for
electric vehicles ielectric vehicles

Sousa revives Noir with sultry thriller Posted on October 16, 2012

DJ L-Koo teams with calendar girls to In yet another instance of green turning
launch new Hollywood hangout imean, famed electric-powered drag racing
wo-wheeler BuzzCycle has set a new
landspeed record for electric vehicles,
iposting a quarter mile time of 8.083
iseconds at Cape Coral Drag Speedway last
iweekend.





image7.jpeg
Ch FASHION + LIFESTYLE
ec EATURES! FASHION ILIFESTYLECALENDAR _NEWS

BuzzCycle sets new landspeed record for
electric vehicles

Sousa revives Noir with sultry thriller

DJ L-Koo teams with calendar girls to
launch new Hollywood hangout

izzCycle sets new landspeed record for electric vehicles
Posted on October 16, 2012

In yet another instance of green turning mean, famed electric-powered drag racing
two-wheeler BuzzCycle has set a new landspeed record for electric vehicles, posting
i quarter mile time of 8.083 seconds at Cape Coral Drag Speedway last weekend




image8.jpeg
In yet another instance of green turning mean, famed electric-powered drag racing
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In yet another instance of green turning mean, famed electric-powered drag racing
wo-wheeler BuzzCycle has set a new landspeed record for electric vehicles, posting
quarter mile time of 8.083 seconds at Cape Coral Drag Speedway last weekend.
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In yet another instance of green turning mean, famed electric-powered drag racing
two-wheeler BuzzCycle has set a new landspeed record for electric vehicles,
posting a quarter mile time of 8.083 seconds at Cape Coral Drag Speedway last
weekend.

At a maximum output of 3200 kw/sec, BuzzCycle can unleash enough torque to
finish the quarter mile within a few thousandths of a second of leading gas-
powered drag racing motorcycles. This capability, combined with an eerie lack of
engine noise, has sparked a new nickname for the cycle and driver Marty Watts:

Silent Violence.
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In yet another instance of green turning mean, famed electric-powered drag racing
two-wheeler BuzzCycle has set a new landspeed record for electric vehicles,
posting a quarter mile time of 8.083 seconds at Cape Coral Drag Speedway last
weekend.
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BuzzCycle sets new landspeed record for
electric vehicles

Sousa revives Noir with sultry thriller

DJ L-Koo teams with calendar girls to
launch new Hollywood hangout

Posted on October 16, 2012

In yet another instance of green turning mean, famed electric-powered drag racing
two-wheeler BuzzCycle has set a new landspeed record for electric vehicles,
posting a quarter mile time of 8.083 seconds at Cape Coral Drag Speedway last
weekend.

At a maximum output of 3200 kw/sec, BuzzCycle can unleash enough torque to
finish the quarter mile within a few thousandths of a second of leading gas-
powered drag racing motorcycles. This capability, combined with an eerie lack of
engine noise, has sparked a new nickname for the cycle and driver Marty Watts:
Silent Violence.

That said, we expect to hear a lot more noise from the BuzzCycle camp as this
year's national MDRA competition approaches.

Posted on October 15, 2012

Already hard at work researching his next film, Mark Sousa has recently been seen
reading up on the private eye genre, according to our own highly leveraged
sources.
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Inside Tesla Motors®

The company that built the first high-
performance, environmentally-friendly
sports car opens up its factory, shares some
of their secrets, and puts the vehicle to the
ultimate test: putting two sworn enemies in
the same two-seater.

read more....
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Stumbling into Mark S.’s Inner Circle
The star from Double Identity, who prefers
installing a skylight to the limelight, talks about
working on the one of the toughest filn
shoots in history, family, and the starlet who’s
not doing a very good job of hiding in his
bathroom
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Facts And Figures

How much thrust would a jet engine need
in order to get the entire city of London off
the ground? We leave that to lesser minds.
But if you want to talk Kierkegaard, you've
come to the right place.

read more....

Today's Self Improvement

Whether you want advice on how to throw
together a killer outfit, a dinner for two, or
a killer punch, we’ve got you covered.
read more...
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BuzzCycle sets new landspeed record for

Posted on October 16, 2012

In yet another instance of green turning mean, famed electric-powered drag racing
two-wheeler BuzzCycle has set a new landspeed record for electric vehicles,
posting a quarter mile time of 8.083 seconds at Cape Coral Drag Speedway last
weekend.

At a maximum output of 3200 kw/sec, BuzzCycle can unleash enough torque to
finish the quarter mile within a few thousandths of a second of leading gas-
powered drag racing motorcycles. This capability, combined with an eerie lack of
engine noise, has sparked a new nickname for the cycle and driver Marty Watts:
Silent Violence.

That said, we expect to hear a lot more noise from the BuzzCycle camp as this
year's national MDRA competition approaches.

Posted on October 15, 2012

Already hard at work researching his next film, Mark Sousa has recently been seen
reading up on the private eye genre, according to our own highly leveraged
sources.

Although the rumor mill places Sousa in the 1940s era film noir homage as a private
investigator working through a tangled web of deceit and murder, Director Eugene
Hedberg has been coyly suggesting these reports are just another public relations
red herring.

We'll be busy pursuing our industry insiders for the vital clues. In the meantime,
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